Description

Simple Building
Slab Design

For LUSAS version: 23.0

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): | RC Slab Design

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description
Four panels of a concrete slab Line Support
supported by a wall, columns and a BB
lift shaft are to be analysed, with Panel A Panel B
reinforcement areas computed for
bending moment only. Shear and Slab Thickness 200mm 6m
displacement checks need to be Conarete 40 N/mm*
carried out separately. The geometry Columns
of the slab is as shown. = e T~
[ ] L9 ]+
The slab is subjected to self-weight Panel C Panel D
and a live load. '
The units of the analysis are N, m, 2« B ;'Sspons em
kg, s, C throughout. '
an
Objective [] ] .
U To produce utilisation plots } 6m ‘F 6m }

under ultimate loads and
check the locations of cracking under service loads

Keywords

2D, Plate Elements, Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel
Area, Load Combinations, Smart Combinations, SLS, ULS, Beneficial, Adverse, Cracking




&

Modelling

N

Simple Building Slab Design

Associated Files

Associated files can be downloaded from the user area of the LUSAS website.

U slab_design_modelling.lvb carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as Slab_Design

e Enter a file path for the working folder.

e Set the Analysis type to be Structural

e Set the Analysis Category to be 2D Grillage/Plate

e Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

o Select the Startup template None from those available in the drop-down list.
o Enter the title as Slab Design Example

e Leave Layout grid set to None and click the OK button.

Note. The Analysis category determines which elements will be available for
modelling. Here we are only interested in the out-of-plane bending effects in a flat slab
and therefore we can approximate this behaviour with 2D plate elements.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.




| Geometry
| Surface >
| By Coords...
| Geometry
| Surface >
| Geometry
| Surface >
|Copy...
| Geometry
| Surface >
| By Coords...
| Geometry
| Surface >
|Holes >
| Create

Modelling

Feature Geometry

J De-select the 3 Columns grid style check box and
enter coordinates of (0, 0), to define the lower left-
hand area of slab, and using the Tab key to move to
the next entry field enter coordinates of (6, 0), (6, 6)
and (0, 6).

e With all the coordinates entered click the OK
button to create a surface.

o Select the newly created Surface.

M Copy the selected surface with an X translation of
6.

e C(Click the OK button to create the new Surface.

e Use Ctrl + A keys together to select the whole
model.

M Copy the selected surfaces with a Y translation of
6. -

e C(Click the OK button to define two new Surfaces.

Defining a Hole in a Slab

Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.

_| Enter coordinates of (2, 2), (4, 2), (4, 4) and (2,
4) and click OK to define the extent of the hole.

e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)

e Ensure Delete geometry defining holes is
selected. A new singular Surface will be created. S




| File
Model Properties. . .
| Attributes
Mesh >
Surface...
| Attributes
Mesh >
Line...

Simple Building Slab Design

This new surface containing the hole can be seen / checked by clicking in a blank part
of the View Window and then re-selecting the lower-left hand surface.

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. For this example, and to give
greater accuracy, 8 divisions per line will be used.

Note. If you are using the Teaching and Training version this default value should be
left unaltered to create a surface element mesh within the limit available. This will give
a coarser mesh and slightly less accurate results.

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select a Quadratic mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions to
be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and drg

the mesh attribute Thick Plate from the
Treeview onto the selected Surfaces

In the vicinity of the lift core less elements are
required.

e Select the element type as None and enter the '
Number of divisions as 4. Enter the attribute M
name as Divisions=4 and the OK button b 1

e Select the 4 lines defining the lift core and drag
and drop the line mesh attribute Divisions=4

from the & Treeview onto the selected Lines.

In this manner the mesh density on slabs can be varied according to the levels of detail
required.




Modelling

Geometric Properties

| Attributes e Enter a thickness of 0.25. Enter the attribute name as Thickness 250mm and click
I% the OK button.
urface. ..

e With the whole model selected drag and drop the geometric attribute Thickness

250mm from the A Treeview onto the selected Surfaces. Click OK to assign to the
selected features for Analysis 1.

Geometric properties are visualised by default.
!l Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

| Attributes e On the RC Material dialog ensure that Country is set to Europe and Design code is
IL/Iaéin'altT> set to EN1992.
ncrete
gr':rs?en/ﬁab e On the drop list for Concrete section select New.
e On the dialog that appears select grade C40/50 and click OK.
¢ On the RC Material dialog for the drop list for Reinforcement select New.
e On the dialog that appears select grade 500B and click OK. Click OK on the RC
Material dialog.
e Select the whole model and drag and drop the material attribute Matl (EN1992)
from the 8® Treeview onto the selected Surfaces.
Supports
| Atibutes e Select Fixed for Translation in Z and enter the
Support... attribute name Fixed in Z and click OK. Select these

Points and

i i ign Fixed in Z
For clarity the mesh layer is not shown on these aBSigR-FxeeR

diagrams. ﬁ & %

e Select the 6 points where the columns are located.

e Assign the supports by dragging and dropping the [

support attribute Fixed in Z from the & i """" & %
Treeview and assign to Points for All analysis </ 7

loadcases by clicking the OK button.
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e Select the 2 Lines representing the line support
and drag and drop the support attribute Fixed in H
Z from the o Treeview and assign to Lines for Select these 2
All analysis loadcases by clicking the OK =
button.

e Select only the top, bottom and left-hand lines ot imsa3
defining the lift shaft and drag and drop the E:] Lifed ahdladsign
support attribute Fixed in Z from the Fireqinz
Treeview and assign to Lines for All analysis
loadcases by clicking the OK button.

El Select the isometric view -m” 1) .
button to check that all supports , /ﬂ'ﬂ :
have been assigned correctly. 'fmm\\ //T
«ft ’ 52
AL <
il o205 o2
< N7 Click this part of the / ﬂmﬁ\ \
status bar to view the model from T "ﬂrm ﬁﬂﬁ b T
the Z direction (plan view) again. TU =
Loading
| Attributes e Sclect Body force, viscous support loading then Body force and click Next.
Loading...
e Enter an acceleration of -9.81 in the Z direction.
o Enter an attribute name of Self Weight and click the Finish button.
| Attributes e Select Distributed loads, then Global Distributed and click Next.
[ Loading...

e Select the Per unit area option.
e Enter -3000 in the Z Direction.
o Enter the attribute name as Imposed Load 3kN/m2 and click the Finish button.

Now the dead and live loading needs to be assigned.

e In the Analyses (5 Treeview, right click on Loadcase 1, select the Rename option
and change the loadcase name to Permanent




| File

Running the Analysis

Save

e With the whole model selected, assign the SR
dead loading by dragging and dropping
the attribute Self Weight from the 6% | .. it

Treeview onto the selection. The loading st i

assignment dialog will be displayed.

Select the Single Loadcase option, the

analysis Analysis 1 and loadcase

Permanent, then click the OK button.

3.0E3 N/m2 0F3 N/m?

e With the whole model still selected, drag
and drop the dataset Imposed Load
3kN/m2 from the A Treeview onto the
selection, accepting all defaults, and
change the loadcase name to Variable and click the OK button.

3.0E3 N/m2

8.0E3 N(m2
e S

Saving the model

El Save the model file.

Running the Analysis

A

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. LUSAS Solver uses
this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (5} Treeview.
In addition, these files will be created in the LUSASFiles\<model name> folder:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

O slab_design.mys this is the LUSAS results file which is loaded
automatically into the (5 Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.



| File
New...
| File
Script >
Run Script...

Simple Building Slab Design

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U slab_design_modelling.lvb carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as Slab Design
e Use the default User-defined working folder.
o Ensure an Analysis type of 2D Inplane is set.

e C(lick the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

e To recreate the model, select the file slab_design _modelling.lvb that was
downloaded and placed in a folder of your choosing.

;l Solve the model to generate the results.

Viewing the Results

Analysis loadcase results are present in the @ Treeview and loadcase results for the
last solved loadcase are set to be active by default.

e In the & Treeview, turn off the display of the Attributes layer.

The Geometry layer is to be retained to allow assignment of reinforcement layout to
surfaces in the model.

e In the C Treeview right-click on results loadcase Permanent and choose Set
active

e With no features selected, click the right-hand mouse button in a blank part of the

active window and select the Contours option to add the contours layer to the
Treeview.




Viewing the Results

Select entity
Force/Moment —
Thick Plate and
results component
MX and click OK
to see the results
for Permanent
effects in the slab
in the global X
direction.

Select entity
Force/Moment —
Thick Plate and

Analysis: Analysis 1
Loadcase: 1:Perman ent

Results file: slab_design-Analysis 1.mys

Entity: Force/Moment - Thick Plate

Compon ent (Averaged nodal): MX (Units: N.mim)

23.4712E3
11.5856E3
0.0

11.5856E3
23171263
34.7569E3
46.3425E3
57.9281E3
69.5137E3

Maximum 80.954E3 at node 18 of element 143
Minimum -23.3166E3 at node 325 of element 112

Analysis: Analysis 1
Loadcase: 1:Permanent

Results file: slab_design~Analysis 1.mys

Entity: Force/Moment - Thick Plate

Component (Averaged nodal): MY (Units: N.m/m)

-11.4305E3
results component 00

11.4305E3

MY and click OK 22.861E3

34.2916E3
45.7221E3

to see the results

for Permanent g woouee:

Maximum 80.42E3 at node 18 of element 143

effects in the Slab smmm oz sereo ot noce 550 of eement 150
in the global Y
direction.

Wood-Armer Results

Slab design will be carried out based on the Wood-Armer moments in the slab. These
results are computed from the orientation of the reinforcement assigned to the slab, so
the reinforcement capacities/details must be defined and assigned to the model before
results can be made available.

Two attributes are available from which Wood-Armer moments can be calculated, and
these are accessed from the Attributes > Wood Armer and Attributes > Design > RC
Slab Design menu items. Since we are going to carry out slab design calculations, we
will need to create and assign to the model an RC Slab Design attribute.
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Defining the RC Slab/Wall Reinforcement attribute

| Attributes e On the Surface reinforcement dialog choose New... from within the cell shared by
[Design the ‘Stretch to fit’ row and column.

Surface

reinforcement. ..

Surface Reinforcement x
Row Column
(® Cartesian zones (O Radial zones Insert Delete Insert Delete
Length Stretch to fit
Srichtoft

y-dimensions

In its simplest form a single set of top and bottom slab reinforcement can be defined.
This can then be assigned to selected surfaces in the model, where it will stretch to fit
the extents of those surfaces that represent the concrete slab.

e On the Surface Reinforcement layout dialog, ensure the top and bottom actual cover
values are set to be 0.02

e Ensure the Angle of bars in y' from bars in x is set to be 90 degrees.
e Enter an Illustrative thickness of 0.2

e Define the bar diameter for the top and bottom reinforcement layers to be 0.02 and
ensure the spacing of bars in the top and bottom layers is 0.15

10



Viewing the Results

Surface Reinforcement Layout

Face Actual cover | Nominal cover podeaibrs Y
from bars in x
Bottam 0.02 Actual thickness
View axis e =
100%
Top
z
= Bottom
3
Row Face Layer Direction Gap Bar diameter Spacing
1 Top 1 x 0.0 00z 0.15
2 Top 2 y 0.0 002 0.15
3 Bottom 2 y 0.0 00z 0.15
4 Bottom 1 x 0.0 0.02 0.15
Mame ‘ srirnfLl | | 2 (new)
Cancel Apaly Help

Click OK to return to the

complete the definition.

previous dialog. Then click OK on that dialog to

Accept the default surface reinforcement layout name of SrfRnfLt1 and click OK.

11
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Assigning the RC slab design attribute

e Select the whole model and drag and drop the
Surface reinforcement attribute Slab reinft

from the Treeview onto the selected

Surfaces.

e On the resulting dialog accept the default
settings and click OK.

Note. Considering the surfaces selected as a single
assignment assigns the reinforcement arrangement
across the extent of all surfaces selected.
Considering each selected surface individually
inserts the defined reinforcement arrangement
within the extent of each surface.

Note. Assigning the Surface reinforcement
attribute adds a new results entity Wood Armer to
the available results.

Assign Surface Reinforcement

Assign to lines
Assign to volumes

Multiple selected surfaces
(®) Consider selection as a single assignment
() Consider each selected item individually
Crientation (reinforcement)
(®) Global axes
Local axes of surface
() specified local coordinate
<Select>

(O Reference path

Create reference path from selec

Circumferential bars for radial reinforcement

x bars y' bars

Cancel Help

12



Viewing the Results

e In the Treeview right-
click on Contours and
choose Properties

e Set the Entity as Wood-
Armer — Thick Plate and
Component as MX(B),
click OK to close the
dialog and plot the
contours

e  Click in an empty region of the view window to deselect the previous selection

Defining Load Combinations

Loadcases will be combined to provide the most adverse loading effects. Different
combination types are required in preparation for the RC Slab Design. This is achieved
using the Design Combination facility within LUSAS Modeller.

Combinations will be provided to EN1990:2002 for ULS Fundamental combination
(using equation 6.10), SLS Characteristic combination and SLS Quasi-permanent
combination.

Defining a design combination

| Design e From the country list select Europe.
Desigr_1 _
[Combinations..___ o From the Design code list select EN 1990 — 2002 Buildings Recommended
Values.

e  For the load Permanent set the type as G | Permanent Actions

e  For the load Variable set the type as Qi B | Imposed: Category B — office areas
e  Click Next.

On the combinations options page:

e Ensure that for ULS the option for Fundamental combination Eq 6.10 is
selected.

13
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e Ensure that for SLS the options for Characteristic combination and Quasi-
permanent combination are selected.

e  Ensure that Create an envelope for each combination type is selected.

e For the Add / Replace / Delete Combinations option, ensure Add is enabled.
e For the Combination approach, ensure Basic Combination is selected.

e  Click Finish to generate the design load combinations.

Plotting results for a design combination

e From the @ Treeview, select ULS_F_B (Min) with the right-hand mouse button
and pick the Set Active option.

e Select the entity  ereosmoon
Force/Moment — 5w oo
Thick Plate and l
-28.7154E3
results a4as77Ed =
component MX JaaomrED
to combine, oy dsonee .
. 71.7885E3
applylng the Maximum 80.954E3 at node 18 of element 143 (3:ULS_F
Vinman 43255425 o node 335 of sament 112 (6014

variable factors
based on the
minimum
moments in the
X direction.

e Ensure Change
existing drawing
layers to above component is selected and click the OK button.

Caution. Whilst not a problem with this example, note that if you use smart
combinations with ‘derived components’ you may not obtain the expected results. The
online help provides details of such circumstances which you should fully understand
before using this facility. In this worked example, a linear primary component is being
used to create the smart combination from which the Wood-Armer values will be
computed. It will be necessary to carry out design checks using primary components in
both directions (X and Y) to ensure the most onerous combination is found.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed

14



B

| Design
RC Slab/Wall
Design...

| Attributes

| Design >
RC Slab/Wall
Design...

Viewing the Results

from the top and bottom reinforcement bar sizes and the covers provided in the RC
Slab attribute.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.

e Ensure that Europe (Eurocode | Reslab/WallDesign ®
recommended Values) and EN 1992-1- Country Europe (Eurocode recommended values) ~
1:2004 are selected from the dropdown  peincose  [enissziizoe
list of countries and design codes

Fartial factors for materials

. . Cencrete (ye)

e  Accept all other settings and click OK. Reiorcing stee 45
Coefficient for long term effects for concrete

we

Defaults OK Cancel Help

RC Slab/Wall Design Attribute

e  On the General tab select the design calculation method as Bending and in-plane
(Sandwich model / Principal stresses) and click OK to add the design attribute to

the A Treeview.

o In the ™ Treeview right-click on results loadcase Permanent (see note below)
and choose Set active

e Select the whole model and drag and drop the design attribute Des1 from the oo
Treeview onto the selected Surfaces.

Note. The Permanent loadcase is set active because a design attribute must be added
to a loadcase and not a combination.

Note. Whilst only the General tab was visited for this example, it is possible to modify
Shear, Min/Max reinforcement, SLS & Creep properties on the other tabs of this
dialog.

15



| Design
RC Slab/Wall Design
Results...

Simple Building Slab Design

Note. For 2D plate models the design calculations options are set to bending only. For
a 3D model comprising shell elements, slab design can be carried out considering in-
plane effects as well as bending.

Adding RC Slab/Wall Design Results

On this dialog, selections can be made to specify which parts of a model should be

checked for which load groups. From the resulting entry in the (5 Treeview the design
check results can be viewed, and tables of results can be obtained.

¢ In the Extent panel, select All members. RC Slab/Wall Design Results (EN 1892-1-1:2004) %
Extent
e In the Design check locations panel = ® aimembers
ensure that Averaged nodal is selected. O Visible members
QO Group Mane
[ ] In the Load Gr()ups panel preSS the (O Reinforcement attribute MNang
Select button for ULS. O Surfaces 17411

Design check locations

e On the Select Loadcases dialog
presented, select ULS_F B (Max) and
ULS_F_B (Min) and add to the Included = 72>

Averaged nodal ~

K X ULS (2 loadcases selected) Select..
hSt' Cth OK SLS - characteristic (2 loadcases selected) Select..
SLS- i- 2 load lected Select..
e In the Load Groups panel press the uasipenmenent (2losdcsses selected
Select button for SLS — characteristic. Design check name Lood group
ULS (B1862) uLs >
e  On the Select Loadcases dialog presented Minmap reinforcement ~
select SLS C B (MaX) and SLS C B SLS (crack control) check (7.3.4) 5L5 - quasiperm... |~
. -, . e SLS limits {7.2) 5LS - chi ie |
(Min) and add to the Included list. Click sress s (72 SEeeihe
Min reinfarcement (7.3.2) 5LS - charactenistic |~

OK.

Advanced options
e In the Load Groups panel press the
Select button for SLS - quasi- Neme | RC Slab/Wal Design 1 <] E ew
permanent.

0K Cancel Apply Help

e  On the Select Loadcases dialog presented
select add SLS_QP_B (Max) and SLS_QP_B (Min) and add to the Included list.
Click OK.

e On the RC Slab/Wall Design Results dialog accept the default name of RC
Slab/Wall Design 1 and click OK to finish.

An RC Slab/Wall Design loadcase entry 5 named ‘RC Slab/Wall Design 1’ will be
added inside a Post processing folder in the (5 Treeview,

16



Viewing the Results

Viewing the Results

In the ©= treeview right-click on the loadcase RC Slab/Wall Design 1 and select

Set Active.

In the & Treeview double-click on the Contours entry to edit the properties.

If needed, select OK on the warning dialog that appears.

Ensure that Entity
is set to RC
Slab/Wall — EN
1992-1-1:2004

and component
set to Util(Max)
and click OK.

It can be seen that the

max

imum utilisation

of 4.82 is above the
single point support
representing the
central column. This
will be investigated further.

Loadcase: 20:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Enity: RC SlabWall - EN 1992-1-1:2004
Component (Averaged nodal): Utii(Max)

0.494872
0989745
1.48462

1.97049
2.47436
296923
3.46411

3.95898
4.45385

Maximum 4.87273 at node 18 of element 254
Minimum 0418879 at node 3 of element 66

In the ™ treeview right-click on the loadcase RC Slab/Wall Design 1 and select

Show Results

On the Summary tab click the Util(Max) label at the top of the last column twice
to sort by utilisation value in descending value.

RC Slab/Wall Design Results (EN 1992-1-1:2004) m} X
SectionlD: | Al ~ SurfacelD: Al v Loadcase: \n/a Face/Direction:  n/a Help
Detailed results for selected row... Display only results for selected surfaces Select surfaces in mode! Select elements in model
Summary Enveloped results  Section definitions  ULS (6.186.2) Minmax reinforcement  SLS {crack cortrol) check (7.3.4)  SLS stress limits (7.2)  Min reinforcement (7.3.2)
Section Surface Element Node Ukil{ULS) Util{Asmin, Asmax) 1KI(CC) Kil(SLS.S) Ltil(AsCC) Ltil (Max) ~
T S T S N 7 NS N N T
1 1 8 18 3 0419 1173 1.545 0.168
1 2 143 18 0419 0.788 0.975 0.168
1 3 175 18 0419 0.850 1.075 0.168
1 4 239 849 0419 0.648 0.747 0.168
1 2 103 849 0419 0.648 0.743 0.168
1 2 110 8313 0419 0.204 0.156 0.168
1 4 239 728 0419 0.347 0.436 0.168
1 2 103 5 0419 0.336 0.429 0.168
1 3 202 M 0419 0337 0.445 0.168
1 2 12 2 0419 0.208 0.389 0.168
1 1 26 2 0419 0.214 0.392 0.168
1 1 41 M 0419 0.338 0.446 0.168
1 4 254 360 0.419 0614 0.749 0.168
1 4 254 522 0419 0.453 0.667 0.168
1 2 143 360 0419 0.499 0.584 0.168
1 3 175 522 0419 0.306 0513 0.168 v
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From the summary table it can be seen that:
e The maximum utilisations are due to the Util(ULS) check.
e The Util(CC) and Util(SLS,S) checks also have utilisations greater than 1.0.

These results are to be investigated further by selecting the appropriate tabs.

Viewing detailed results for a slab location
Util(ULS) Check results

e On the main RC Slab/Wall Design Results summary table select the ULS (6.1 &
6.2) tab.

e Expand the width of the table and sort the Util(Max) column in descending order.

It can be seen that the peak values are due to the shear check Util(VRdc).

RC Slab/Wall Design Results (EN 1992-1-1:2004) = o X
SectioniD: | Al v SurfacelD: |Al ~ Loadease: Al - Face/Direction: | Al v Help
Detailed results for selected row. Display only results for selected surfaces ‘Select surfaces in model ‘Select elements in model

Summary Enveloped resutis Section definkions ULS (618:62) Min-max reinforcement _ LS (erack conirol) check (7.3.4) SLS stress limis (7.2) Min reirforcement (7.3.2)

Section Surface Element Node Loadcase Face/Direction Util(As) Li(TC) LKil(Sc) Ltil(vRdc) LtilVRdmax) [mn"v\i/vmﬂ Ltil{Max) =
N T S T O O N S S N |
1 4 25 18 10ULS_F_B - Myy TopX 1.006 032 0958 4873 = - 44873
1 4 254 1% SULS_F_B-My BottomX. 0.000 0.000 0.977 4873 - - 3
1 4 254 18 SULS_F_B-My TopX 1.006 0322 0.958 873
1 4 254 18 SULS_F_B-Mx BattomY 0.000 0.000 0977 4873
1 4 254 18 10:ULS_F_B - Mxy BottomX 0.000 0.000 0.977 4873
1 4 254 18 10:ULS_F_B-Sy TopY 1.097 0.355 0.958 873
1 4 254 18 10:ULS_F_B - Mxy TopY 1.097 0355 0.958 4873
1 4 254 18 10:ULS_F_B - Mxy BottomY 0.000 0.000 0.977 4873
1 4 254 18 10:ULS_F_B-5x TopX 1.006 0322 0.958 873
1 4 254 18 10:ULS_F_B-5x BottomY 0.000 0.000 0.977 4873
1 4 25 18 10:ULS_F_B-Sy BattomY 0.000 0000 0977 4873
1 4 254 1% 10:ULS_F_B-Sx BottomX. 0.000 0.000 0.977 487
1 4 254 18 10:ULS_F_B-Sy TopX 1.006 0322 0.958 4873
1 4 254 18 10:ULS_F_B-Sy BottomX. 0.000 0.000 0977 4873
1 4 254 18 GULS_F_B-Mx TopY 1.097 0.355 0.958 4873
1 4 254 18 10:ULS F B-5x TopY 1.057 0.355 0.958 4873 ~

Util(CC) check results

e On the main RC Slab/Wall Design Results summary table select the SLS (crack
control) check (7.3.4) tab.

e Sort the Util(CW) column in descending order.
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Viewing the Results

RC Slab/Wall Design Results (EN 1992-1-1:2004)
SectionlD: | Al ~ SurfacelD: |Al ~ Loadcase: |Al v Face/Direction: | Al

Detailed resulfs for selected row. Display only resulfs for selected surfaces Select surfaces in model Select elements in model

Summary Enveloped resuits Section definitions  ULS (6.14 6.2) Min-max reinforcement | SLS (orack control) check (7.34) | SLS stress imits (7.2) i reirforcement (7.3.2)

~ Help

Section Suface Eement Node Loadease Face/Direction _ Eceff [GPa] fs [MPz] Uti(CW)

s w | mssass | tec | wws | som | ou |
1 4 254 13 18:5L5_QP_B - Mx TopX 10.9375 519.881 1174
1 4 254 18 18:5L5_QP_B - My TopX 10,9375 519.881 1174
1 4 25 13 19:5L5_QP_B- My TopX 10.9375, 519.881 1174
1 4 254 18 19:5L5_QP_B- Sy TopXk 10.9375 519.881 1174
1 1 81 18 19:5L5_GP_B - Mxy TopX 10,9375 519.697 1173
1 1 81 18 18:SLS_QP_B - Sx TopX 10.9375 519.697 1173
1 1 2 18 18:SLS_QP_B - My TopX 10.9375 519.697 1173
1 1 81 18 18:5LS_GP_B - Mx TopX 10,9375 519.697 1173
1 1 81 18 18:5LS_QP_B- Sy TopX 10.9375 519.697 1173
1 4 25 18 18:5L5_QP_B- My TopX 108375, 450402 1024
1 4 254 13 18:5L5_QP_B - 5x TopX 10.9375 454482
1 4 254 18 18:5LS_QP_B - Sy TopX 10,9375 454442
1 4 254 18 19:5LS_QP_B - Mx. TopX 10.9375 454442
1 4 254 18 19:5LS_GP_B - My TopXk 10.9375 454447
1 1 81 18 19:5LS_QP_B - Sx TopX 10,9375 45428
1 1 81 18 18:5L5_QP_B - Mxy TopX 10.9375 45428 1.023

Investigating Util(CC) results further

e Select the first row in the SLS crack control check table and then click the Detailed
results for selected row button at the top of the dialog. Double clicking the row

will also give the detailed results.

e In the Design Calculation Viewer select the SLS (crack control) check (7.3.4) and
scroll through the results to view data relating to bar spacings and utilisation.

Failures are highlighted in red text.

From the calculations it can be seen that for crack width calculations for the top face of
the slab, the reinforcement spacing limited has been satisfied in both the x and y
directions but the crack width utilisation exceeds 1.0 in the x-direction.

Caleulation of crack widsh

Crack width

Wi = Srmax * (Esm = £cm) = 137.57 - (2.55931E-3) = 0.352084 mm
Allowable crack width Wiim = 0.3 mm
Crack width utilisation Ueil(CW) = 1.17361

Cracks controlled by the y direction reinforcement

Moment most closely aligned to y axis M = B32174E6 Nmm

Angle of moment o=4624°

e (Close the Design Calculation Viewer.

Util(SLS,S) check results

e On the main RC Slab/Wall Design Results summary table select the SLS stress

limits (7.2) tab.
e  Sort the Util(Max) column in descending order.

The maximum utilisation is due to the check on Util(sigmaS).
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Simple Building Slab Design

RC Slab/Wall Design Resuits (EN 1992-1-1:2004)
SectionlD: | Al ~ SurfacelD: |Al ~ Loadcase: |Al v Face/Direction: |Al ~

Detailed resulfs for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary Enveloped resuits  Section defintions  ULS (6.1 6.2) Min-max reinforcement _ LS (crack control) check (7.3.4) SLS stress limis (7.2)  Min reirforcement (7.3.2)

Help

Section Suface ement Node Loadease Face/Direction _Ecef [GPa] Utlisignas) _ Lki(sigmaC) Uti(Max)

N O S S Y 2 - N N T N
1 4 254 18 15:5L5_C_B-5x TopX 10.9375 1546 0.000 1546
1 4 254 18 14:5L5_C_B -My TopX 10.9375 1.546 0.000
1 4 25 18 15:5L5_C_B-Sy TopX 109375 1545 0.000
1 4 254 18 14:5L5_C_B - Mx TopX 10.9375 1546 0.000
1 1 81 18 14:5L5_C_B-5x TopX 10.9375 1545 0.000
1 1 81 18 14:5L5_C_B - TopX 109375 1545 0.000
1 1 a1 1% 15:5LS_C_B - Mxy TopX 10.9375 1545 0.000
1 1 81 18 14:5L5_C_B-My TopX 10.9375 1.545 0.000 1.545
1 1 31 18 145LS C_B-Sy TopX 10.9375 1545 0.000 1545
1 4 254 18 155LS C_B-Sy TopY 10.9375 15331 0.000 15331
1 4 254 18 14:5L5_C_B - Mx TopY 10.9375 1533 0.000 1533
1 4 254 18 14:5L5_C_B -My TopY 10.9375 1533 0.000 1533
1 4 254 18 15:5LS_C_B - Mxy TopY 10.9375 1531 0.000 1531
1 4 254 18 15:5L5_C_B-5x TopY 10.9375 1533 0.000 1533
1 1 81 18 14:5L5_C_B -My TopY 10.9375 1532 0.000 1532
1 1 81 18 14:5L5 C_B-5x TopY 10.9375 1532 0.000 1532

e Close the RC Slab/Wall Design Results.

Viewing the contour plots

The contour plots for the results of interest will now be viewed. This is best done using
the Design contours option that shows values of utilisation from 0.7 to 1.0 and above.

e In the == Treeview double-click on the contours layer.

e  Ensure the Entity is set to RC Slab/Wall — EN 1992-1-1:2004 and the component

is set to Util(Max).

e Select the Appearance tab and select the Design option. Press OK.

The contour plot is as shown below.

20



Viewing the Results

Loadcase: 20:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)

Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(Max)

07
I
1.0

Maximu m 4.87273 at node 18 of element 254
Minimum 0. 418879 at node 3 of element 66

Similarly the plots of interest for Util(ULS), Util(CC) and Util(SLS,S) follow:

Util(ULS)

Leadcase: 20:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)

Entity: RC Slab/Wall - EN 1892-1-1:2004
Component (Averaged nodal): Util(ULS)

o7
.,

08

1.0
Maximum 4.67273 at node 18 of element 254
Minimu m 0222804 at node 5 of element 86

“nd]
i

.‘\\\

o

<\
L)

[/

|/
1r
g%
L
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Simple Building Slab Design

util(cC)

Loadcase: 20:RC Slab/Wall Design 1 (EN1982-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Utl(CC)

0T
),

10

Maximum 1.17361 at node 18 of element 254
Minimum 1.00452E-3 at node 1425 of element 231

Util(SLS,S)

Loadcase: 20:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(SLS)

07
.

10

Maximum 1.5457 at node 18 of element 254
Minimum 0.167534 at node 1 of element 66

Further contour plots are available which can provide additional information. For
example the plot of Util(CC) can be separated into top and bottom checks, Util(CC(T)
and Util(CC(B)) receptively as shown below.
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Viewing the Results

Util(CC(T))

Loadcase: 20:RC Slab/MWall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall -EN 1992-1-1:2004
Component (Averaged nodal): UtI(GC(T))

0.7
|y

1.0

Maximum 1.17361 at node 18 of element 254
Minimum 0.0 at node 59 of element 27

util(CC(B))

Loadcase: 20:RC Slab/Wall Design 1 (EN1992-1-1 (Eurepe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): UtI(CC(B))

0.7
B

1.0

Maximum 0.309451 at node 395 of element 109
Minimum 0.0 at node 18 of element &1

From this it can be seen that the Util(CC(T)) is critical over the central column support
while the utilisation of Util(CC(B)) is less than 1.
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Notes regarding utilisations obtained

The objective of this example is to demonstrate the use of the RC slab/wall design
facility. To this end the modelling of the structure has been somewhat simplified.

A more accurate model could be considered by the inclusion of details such as column
heads or drop panels as necessary. Also, the modelling approach could be developed to
include the columns themselves or to provide constraint equations to reflect behaviour
more accurately at the head of the column.

In addition, the plate/shell elements in LUSAS are high performance. Therefore, the
effects of stress concentration may be considerable, as is the case in this example. As
with any finite element software, engineering judgement should be applied when
analysing the results.

As a result of this there are very high utilisations at and around the support locations.
Whilst some increase to the area of reinforcement is required to particular regions the
previous comments should be noted when considering the reinforcement requirements
near the supports.

Save the model

Fil
| I|;ave— El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
/ model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.

Discussion

Element types and orientation of results

The orientation of the slab reinforcement is aligned with the results axes. In this
example thick plate elements are used whose results axes are always transformed to the
global directions.

A Caution. If shell elements are used (when they may be appropriate) the results must
s be transformed into a consistent direction coinciding with the intended direction of the
reinforcement. Note that by default shell results are orientated along the local element
axes.
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Discussion

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transform Set... button on a
results layer’s Properties dialog. Selecting Global axes will transform local
element results into the global axes system. Other options are available.

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase x, y and z (when seen) are used to denote local results or
transformed results.

Element density and results obtained

If the Teaching and Training version of LUSAS was used to carry out this example
with a reduced default mesh density of 4 divisions per line a reduced accuracy of
results will be obtained.

In general, more accurate results are obtained when using more line mesh divisions and
hence more elements when modelling slabs of this type. Care should always be taken to
use an appropriate number of elements together with a possible refinement of the mesh
in areas of interest in order to obtain the best results.
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